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1 Introduction
Python Tools for Visual Studio provides Python programmers with a great development experience inside of Visual Studio and enables Visual Studio developers to automate VS with Python.  Python Tools for Visual Studio (Python Tools for short) is a set of components that extends Visual Studio.  It supports editing, debugging, creating Python projects, and participating in VS solutions.  Python Tools also enables scripting VS from Python files and an embedded REPL.
Python Tools for Visual Studio ships as a MSI which installs a Visual Studio extension for developers who already have Visual Studio 2010 installed.  The extension also works with the VS Integrated Shell, which is free.  We might also provide a stand-alone download with Python Tools for Visual Studio and the Integrated VS shell.
2 Features

Features are tagged with priority and or staging indicators.

· "Pycon" indicates the feature will be working completely or to some extent by 22 FEB 10.

· "P1" means the feature will be working before we declare a v1 release.  When we can feel solid enough and feature rich enough to declare a v1 depends on other team priorities and our resources.

· "P2" means we'll get to the feature as soon as possible, but we don't think we need it to declare a v1.
The primary use of Python Tools for Visual Studio is writing Python code, so the early focus needs to be great editing with code modeling or IntelliSense® features.  Python Tools’s editing experience should be similar to other tools in Visual Studio.  For example, code is colorized, member completion works, parameter tips pop after typing a function name and an open parenthesis, outlining works, and so on.

2.1 Python Versions Supported

Python Tools supported Python 2.5 through 3.1.The default install will recognize installed CPython installations which come from python.org as well as IronPython 2.7 or later.  These interpreters will automatically be configured and the user can select the interpreter to be used on a per-project basis and can also set the default interpreter.  Interactive REPL windows will be available for all installed Python interpreters.
2.2 Editing and Navigation
2.2.1  IntelliSense® Completion
Python Tools for Visual Studio should have the best code modeling of any python tool.  This along with a great editor/REPL interaction experience will set Python Tools apart from others.  Our code analysis will model all possible return values from functions, calls to function that inform understanding return types, assignments, and many other aspects of the code.  The analyzer will determine little about return values for highly dynamic code that uses __getattr__ and __getattribute__.  For uses of statically typed (.NET library) code we infer most types.

A quick glance at other tools suggests they are not very rich in their code modeling.  Many seem to be lacking for basic member completion; some just provide any member name on any and all objects.   Some tools don't analyze arguments passed to functions when they can reveal return type information.  None seem to do any analysis on core data types such as lists and dictionaries, though IDLE provide parameter tips for built-ins.  We aim to do better than all of these existing tool experiences.
2.2.1.1 Completing Members with Multiple Types Possible

There is a design choice for completion of members on parameters, function returns, or variables assigned multiple types.  If you view completion as a poor-man's in-situ browser or discovery tool, you want to see all members for all possible types that are known to flow to this point of the code.  If you view completion as paternalistic guidance, you want to see only those members for which you know you can call without error.
By default, Python Tools only shows the members it knows you can call.  If it has no type info at the completion site, there will be no members shown.  If there are multiple types it knows can flow to this point, Python Tools only shows the intersection of members with the same names on all types.

 There is a tools option to cause Python Tools to show all possible members on all possible types that are known to flow into a completion site.

A couple of ideas for providing choice to the user is to use the tabbed capability of the completion pop-up or to use coloring of the items in the list if that's possible.

2.2.2 Find All References

Based upon the analysis provided for intellisense it is easy to provide a find all references feature – although the feature may sometimes not find all references.

All navigation in Python Tools centers the target line or selected span of text in two cases.  The first if part of the span is out of the view of the current window.  The second is if the location is on the first or last line of the window.  This behavior allows you to see more context around the location without needlessly jerking the display.

 Goto Definition

Also based upon the analysis provided for completion, it is easy to provide a goto-definition feature.  This feature will sometimes not be able to goto the definition requested because the defining location cannot be determined.  In that case there needs to be some user notification that the feature is unavailable.  Alternately a mechanism for notifying the user that the feature is available needs to be provided.  Definitions in Exec string arguments are never found.
If there are multiple possible defining locations, or the tool cannot disambiguate, it lists all possible locations from which you can choose.

All navigation in Python Tools centers the target line or selected span of text in two cases.  The first if part of the span is out of the view of the current window.  The second is if the location is on the first or last line of the window.  This behavior allows you to see more context around the location without needlessly jerking the display.

The tool goes to assignment locations for globals, locals, and class members.  For example, if you set class attributes in the __init__ method, we'll go to those locations as the definitions.  The tool shows all assignment locations in a disambiguation list from which you can choose where to go.

2.2.3  Navigation Bar
Similar to other languages the left dropdown contains all class definitions in the current document, including nested definitions.  The right dropdown contains all function definitions for the currently selected class in the left dropdown.  Because Python supports top-level functions, the left dropdown also contains all top-level functions.  Module scoped variables that are simply assigned to (that is, not defined as a class or function) are in the left dropdown.  If there are multiple assignments to the same variable at top level, the dropdown shows them all.
All navigation in Python Tools centers the target line or selected span of text in two cases.  The first if part of the span is out of the view of the current window.  The second is if the location is on the first or last line of the window.  This behavior allows you to see more context around the location without needlessly jerking the display.

2.2.4 Identifer Completion

Python Tools will support identifier completion like IDLE does.  This is very useful for completing names in comments and if you enter a call to a name before defining it.  This feature is nearly the same as you get in C# with c-spc on a local or member name, but it should be more reliable when the name is not recognized semantically.

The binding is m-/.

2.2.5 Fill Comment Paragraph

2.2.6 Smart Indent

2.2.7 Comment / Uncomment Region

2.2.8 Goto matching delimiter

2.2.9 Highlight matching braces
2.3 Refactoring

Python Tools for Visual Studio initially includes only a couple of the most used refactorings.  We will add others based on demand and other priorities.
2.3.1 Extract Method

Extract method is the safest to perform.  Lexically we know which references are to locals, globals, or closure variables.  Python supports multiple return values, so passing values in and out of the code are easy source transforms.
2.3.2 Rename Variable
This feature works within strings and comments since when you're renaming something, you'd like any error reporting strings or comments to reflect the new name.  Other languages in VS get this right now too.
This feature is only reliable for locals and parameters.  The feature cannot be reliably provided for class members or module globals.  There are a few examples.  In this code, we may not catch all patterns for this sort of highly dynamic reference:

import sys

sys.modules["foo"].SomeGlobal

It might be something as simple as importing from a module and redefining something you don't use in that module, which just adds complexity to the code modeling:

from Blah import *    #Blah has a def foo ().

...

def foo ...

In this code, if you can't know whether to rename SomeMember if starting from the type, or which type to change if starting from the reference site:
def f(x):

   if x.__class__ == str:

      return OneThing()

   else:

      return Another()

f(42).SomeMember()

We have a few options:

· Provide a version that may rename incorrect call sites.
· Provide a query replace version with UI to preview locations and individually opt them in or out of the renaming.  This is a refinement to the first option.
2.3.3 Add Import
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New in 1.1.

The add import feature is made available via a smart tag menu which pops up on an identifier which currently has no type information available via the analysis.  When the caret is moved to the identifier a smart tag is offered to the user which can be invoked using the mouse or the keyboard short cut.  The user is then displayed a menu which includes a list of available names which can be imported.  Selecting one of the options causes the import to be inserted at the top of the file after the other imports or into an existing from … import statement if the user’s code is already importing from that module.

2.3.3.1 When the smart tag is available

The smart tag is available only when there is no type information available for the given identifier.  For example if the user assigns to the name even though it’s available in another module the smart tag will not be offered.  The identifier must also be a simple name, the smart tag is not offered when the user is in a member expression and the outer name represents a package name.  Finally we must know of at least one module or module member to offer for the list of imports.  This module or module member can exist in either the users’ project or in the cached analyzed standard library.

2.3.3.2 What imports are offered

The smart tags will offer both imports and from … import smart tags.  

Import completions will be offered for top-level packages and modules and will insert “import xyz” statements at the top of the file after the doc string and any existing imports.  

“from … import” completions will be offered for sub-modules and sub-packages as well as module members.  This includes functions, classes, or exported data.  

Both “import” and “from … import” smart tags will be offered for both members in the users’ project as well as members from the cached standard library.

PTVS attempts to filter out members which are not really defined in a module.  This includes filtering out any modules which are imported into another module/package but aren’t a child of the module/package doing the importing.  For example the “sys” module is frequently imported in lots of modules but you don’t usually want to do “from xyz import sys”, instead you want “import sys”.  Therefore PTVS will not offer a completion for importing “sys” from other modules even if the modules are missing an __all__ member which excludes sys.

There’s also a similar level of filtering for functions which are imported from other modules or from the built-in namespace.  For example if a module imports the “settrace” function from the sys module then in theory you could import it from that module.  But the correct place to import settrace would be directly from the sys module.  Therefore we don’t offer imports of functions from one module when the function has been defined in another module.

Finally if something would be excluded due to the rules above but has other values that would be included (for example because the name was assigned a value in the module) the import will still be excluded.  This is making the assumption that the value should not be exported because it is defined in another module – the additional assignment is likely to be a dummy value which is also not exported.

2.3.3.3 How imports are inserted

Imports are always inserted after a doc string and after any other existing imports.  Imports are not sorted in any way and there’s no sort feature as imports are executable statements which can have side effects impacting how other imports proceed.
2.3.3.4 How from imports are inserted

“From … imports” are inserted like imports if there is no existing import from the module that the “from … import” is targeting.  If there is an existing “from … import” statement which targets the same module then that statement is updated to include the additional value being imported.

2.3.3.5 Public API for Extensions

This feature also exposes the missing import analysis to users who wish to extend Python Tools for Visual Studio.  A new extension method is defined on ITextSnapshat which enables querying the list of missing imports.  This method returns a new MissingImportAnalysis class which includes the list of missing imports.

GetMissingImports

public static MissingImportAnalysis GetMissingImports(this ITextSnapshot snapshot, ITrackingSpan span);

Returns the missing import analysis which includes the list of 
MissingImportAnalysis

Provides information about names which are missing import statements but the

name refers to an identifier in another module.  This class is sealed and does not contain a public constructor.

AvailableImports

IEnumerable<string> AvailableImports {

     get;
}

The locations this name can be imported from.  The names are fully qualified with

the module/package names and the name its self.  For example for "foo" defined in the "bar"

module the name here is bar.foo.  This list is lazily calculated (including loading of cached intellisense data) so that you can break from the enumeration early and save significant work.

ApplicableToSpan
ITrackingSpan ApplicableToSpan {

     get;
}

The span which covers the identifier used to trigger this missing import analysis.  This value can be null if there is no valid imports.
PythonAnalyzer.FindNameInModules

IEnumerable<string> FindNameInAllModules(string name);

This base API returns a list of names which are exported from modules including module names themselves.  This forms the core of the missing module API.  

This API returns exported members as defined in “What imports are offered”.  In other words functions and classes defined in other modules but imported into a module are filtered out.  This applies to both user defined functions and built-in functions.

2.3.4 Remove Import

New in 1.1.
This feature enables the user to remove unused imports from within a file.  This feature exposes two new commands, one for removing imports from the current scope and one for removing imports from all scopes.  These commands are exposed via the editor window context menu “Remove Imports” which has two sub-items “Current Scope” and “All Scopes”.  The “All Scopes” command is by default bound to the keyboard shortcut Ctrl-K Ctrl-O (knocking out those unused imports!).  

This is similar to C#’s “Organize Usings” feature.  It differs in that there is no option to sort imports as their order can be significant within Python code while in C# their order does not matter.  We also add the feature to remove usings from either the current scope or all scopes as import statements can occur at different scopes and this is significant.

During the analysis this feature will only look at names which are imported and whether or not that name is used in any scope below where the import occurs.  There will be no accounting for control flow – for example using a name before an import statement will be treated as if the name was in fact used.

The analysis will ignore all “from __future__” imports, imports that are performed inside of a class definition, as well from from … import * statements.

2.3.4.1 Remove Imports -> Current Scope

The current scope command will determine the current scope based upon the location of the caret.  It will then identify all of the import and from import statements directly enclosed in the current scope.  It will then determine all of the identifiers used in the current scope and any children scopes.  Finally it will remove the imports or from import statements for any identifiers which were not used.

2.3.4.2 Remove Imports -> All scopes

In this mode the entire file will be processed for all imports.  First all imports used anywhere in the file will be determined.  Next all names which are referenced will be analyzed.  Finally any “import” and “from … import” statements whose names have not been used will be removed.

2.3.4.3 Removal

Removal of the imports will perform updates removing the imports while otherwise preserving the structure of the users’ code.  For import statements which include multiple modules being imported via a single import statement the import statement will be updated to remove any relevant imports.  If all imports are removed then the entire import statement will be removed while still preserving any leading or trailing comments.

Likewise for a “from … import” statement if multiple values are being imported then the unreferenced imports will be removed.  If this results in no imports occurring then the “from … import” statement will be removed in its entirety again while leaving any leading or trailing comments.

If the statements are removed in their entirety then it’s possible that an invalid program has been produced by having a missing empty statement in a function definition.  In this case a new empty “pass” statement will be inserted into the buffer where the import or from import statement has been removed.
2.4 Project System

Python Tools for Visual Studio does not require an explicit project to get started, as with classic VS overhead.  Nor does it require a class and a Main to execute code.  You can use c-o to open a file and immediately start getting smart editor features or run the file.  When used this way Python Tools creates an implicit project to work well in the VS shell model.  
The explicit project works in a similar manner to other languages within Visual Studio.  The project file lists the filenames included in the project.  You can explicitly add or remove files from the project.  The project in the Solution Explorer immediately reflects these changes.  
If you have a directory structure with distinct python package directories, each may have its own project file and show up as parallel projects rather than sub folders.

Consider an option for only including sub directories if they contain an __init__.py file.

Revisit model that each sub directory with a .pyproj file is a parallel project in the solution, and those sub directories are not included in parent projects as sub folders

When you create an explicit project, Python Tools writes a .pyproj file in the directory.  You can incorporate these projects into solutions, which may include VB, C#, or kinds of projects.  

Explicit projects have a start item.  This is the file executed when you invoke "Execute Start Item in Python Interactive" (c-a-s-F5).  As with the implicit project, the REPL's execution state is re-initialized on c-a-s-F5.  You can change the start item, and you can right-click to unselect the start item (or going to the project properties page).
Explicit projects also persists various standard options, such as default command line switches for launching ipy.exe.  The options persist within multiple build configurations so that, for example, Release runs can support the –O option, and Debug runs can specify –D.

The project file also persists:

· the ipy.exe path for executing code

· the current working directory option
2.4.1 Project Properties

The project properties pages are accessible by selecting Properties or selecting “[ProjectName] Properties…” from the project menu or right clicking on the project node and selecting Properties.

The project properties experience is similar to the C# and VB.NET project system where there are multiple tabs of options for different settings for the project.  The available options can change based upon the features the user has installed for PTVS.
2.4.1.1 General
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The general page lets the user select options which are broadly applicable to most programs. The following options are available:

2.4.1.2 Startup File
This option lets the user select the file which will be launching the program via the various launch mechanisms (Debug->Start with Debugging, Debug->Start without Debugging, etc…).  This option can also be configured by right clicking on a file and choosing Set as Startup File within Solution Explorer.
Working Directory

This specifies the working directory when launching a Python interpreter.  
Windows Application

When this box is checked the Windows interpreter will be used instead of the command line interpreter.  Typically this means pythonw.exe will be launched instead of python.exe.
Interpreter
This specifies the interpreter which will be used for launching this project.  The list of interpreters here is the same as the list configured in Tools->Options->Python Tools->Interpreter Options.   If this setting is unset then the default interpreter that is configured in Interpreter Options is used.
2.4.1.3 Debug
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This page configures debugging options including options which are specific to different launch modes.

The typical user will be using the “Standard Python Launcher” which uses PTVS’s built-in debugger for Python programs.  
Other launch modes can be provided by implementing the IPythonLauncherProvider interface defined in the extensilbiity section.

For more information see the Debugging section.

Search Paths

This setting controls the PYTHONPATH environment variable which is set to the value that is stored here.  This value can also be edited via the Solution Explorer “Search Paths” node which lets you add or remove a list of search paths instead of editing the string.
Script Arguments

This specifies arguments which are passed to the script which is being launched.  When launching the Python interpreter these arguments come after the script filename.
Interpreter Arguments

This specifies arguments which are passed to the Python interpreter.  When launching the Python interpreter these arguments come before the script filename. An example would be –O to enable optimizations.
Interpreter Path

This overrides the interpreter path which is being used for the script.
2.4.1.4 Debug -> MPI
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If the user has installed the MPI extensions and selects the MPI Cluster launcher in the debug pages they get a larger set of options related to launching and running on a cluster.  This launch mode supports deploying the users application to a cluster and starting it using the Windows HPC job scheduler.  If the user launches in debug mode then the debugger will launch all of the processes on the remote process and enable debugging them simultaneously.  
Run Environment
String that includes the head node, number of processes, and the allocation of processes to machines, if specified.

Target platform

Selects the target platform (X86 or X64).  This option must match the platform of the interpreter that will be running on the cluster.
Publish before run

True if the project should be published (to location in publish settings) before run.

Python Interpreter

Path to the python interpreter on the cluster nodes.

Application Arguments

This specifies arguments which are passed to the script which is being launched.  When launching the Python interpreter these arguments come after the script filename.
Interpreter Arguments

This specifies arguments which are passed to the Python interpreter.  When launching the Python interpreter these arguments come before the script filename. An example would be –O to enable optimizations.
Deployment Directory

Path to deployed files accessible on the cluster.  Usually empty, this overrides the publishing path when publishing to something other than a file share.  For example if publishing via FTP this is a path which is accessible by all of the nodes of the cluster locally.

Working Directory

Working directory used by each process.  If not specified the default is a directory in %TEMP%.

MPIExec command

Path to mpiexec.exe on the cluster nodes for starting the program under MPI.  Usually this is empty and mpiexec and the value “%CCP_HOME%\\Bin\\mpiexec.exe” is used.
2.4.1.5 Debug -> IronPython
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This launch mode is available if the user has installed the IronPython extensions for PTVS.  This uses Visual Studio’s built-in .NET debugging facilities to debug IronPython applications.  This enables debugging not only the Python source code but also portions of the program written in other .NET languages.
Search Paths

This setting controls the IRONPYTHONPATH environment variable which is set to the value that is stored here.  This value can also be edited via the Solution Explorer “Search Paths” node which lets you add or remove a list of search paths instead of editing the string.
Script Arguments

This specifies arguments which are passed to the script which is being launched.  When launching the Python interpreter these arguments come after the script filename.
Interpreter Arguments

This specifies arguments which are passed to the Python interpreter.  When launching the Python interpreter these arguments come before the script filename. An example would be –O to enable optimizations.
Interpreter Path

This overrides the interpreter path which is being used for the script.

Debug Standard Library

When this option is unchecked the standard library will be un-debuggable.  This provides significant startup performance because compiling code to enable debugging is significantly slower than compiling code normally.
2.4.1.6 Publish
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The publish page configures how a project will be published.  Different publishers may be registered using the IProjectPublisher interface defined in the extensibility section.  By default an FTP and UNC share publishers are available.
Projects can be published by right clikcing the project node in Solution Explorer and selecting Publish.  Some launch modes (such as the MPI cluster launcher) may optionally automatically publish before running.
The Project Node
2.4.1.7 Properties Pane
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Files

2.4.1.8 Properties Pane
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Linked Files

New in 1.1.
[image: image9.png]


 Linked files appear in solution explorer as normal files with a shortcut icon overlayed on top of them.  Linked files can exist either at the top-level of the project or embedded within an arbitrary folder structure.

Linked files are specified in the .pyproj file using the normal <Compile Include> tag.  They can be implicit linked files if they use a relative path outside of the directory structure or they can be explicit link files by specifying their path within solution explorer:
    <Compile Include="..\test2.py">

      <Link>X\test2.py</Link>

    </Compile>

Linked files specified in a project file will be ignored under the following conditions:

· When the linked file contains Link metadata and the path specified in the Include attribute lives within the project directory.
· When the linked file duplicates a file which exists within the project hierarchy

· When the linked file contains Link metadata and the Link path is a relative path outside of the solution explorer hierarchy.



· The link path is rooted

2.4.1.9 Adding Existing Items as Links

To add an existing item as a link the user can use the Project->Add Existing Item menu (or the context menu), select a file, and choose “Add as Link” from the drop down on the Add button.  This will create a link at the existing selected level in Solution Explorer.
When creating a link to a file which lives within the project directory or a child directory the file will be added to the project in the correct location as a normal file instead of a link.
2.4.1.10 Creating New Linked Files

A user can create a linked file via the user interface by doing File->Save As for a file which exists somewhere within the project hierarchy.  The old file node in the project will be removed and replaced by a linked file node (the link is created at the same location in the hierarchy as the previous node).  The old file on disk will not be deleted.
2.4.1.11 Converting Linked Files to Normal Files
A linked file can be converted into a normal file by doing File->Save As and saving the file into a location within the project hierarchy.  The node in the project hierarchy will be moved into the appropriate location in solution explorer
2.4.1.12 Moving Linked Files

When using the solution explorer UI to move a linked file the end result is that the link moves but the file on disk remains unaffected.  If the file was open in the editor the file will remain open.
2.4.1.13 Deleting Linked Files

When using the solution explorer UI to delete a linked file the end result is that the link is removed from the project and the file remains on disk.  The user is not prompted for the option to delete the file.
2.4.1.14 Renaming Linked Files

Renaming of linked files will not be allowed.   Both renaming on the node as well as renaming via project properties will be disallowed.  Attempting to rename a file via the automation API will raise an InvalidOperationException.
2.4.1.15 Duplicate Linked Files and Normal Files

If a project contains both a linked file and a normal file at the same level of the solution hierarchy the linked file will be renamed.  When adding a new file or link to the project if an existing file or link exists at the same level in the hierarchy then the addition will not be allowed.  Additionally if a link to a file already exists anywhere within the project a second link will not be permitted to be added.  If the user modifies the project by hand to introduce duplicate links then only one link will be added when loading the project file.
2.4.1.16 Search Paths

When the user adds a new linked item to the project the project search paths will be updated so that they contain a reference to the directory containing the newly added files.  If the files being added live within a project (there is an __init__.py at the same level as the files) the 1st parent directory which is not a package will be added.

The user can disable this behavior via the Tools->Options->Python Tools->Advanced page.
2.4.1.17 Properties Pane
The linked file properties pane is identical to the file properties page with the exception that the filename is read only.
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2.4.1.18 Folders

2.4.1.19 Properties Pane
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The search paths node controls what directories PTVS will search in for associated files.  PTVS will also pass these paths on to the executing Python interpreter by setting its PYTHONPATH environment variable to contain the search paths.  
Because these paths get passed onto the executing interpreter via PYTHONPATH PTVS will also analyze any .py files which are included in these directories and provide intellisense against them.

In addition to using the search paths for .py files when working with an IronPython interpreter PTVS will look for referenced .NET assemblies to include in the analysis.  The analyzer will still need to find a call to clr.AddReference* call for the assembly’s members to be available for completions.
PTVS will make sure to load the assembly without locking it on disk.  If the file is changed on disk then PTVS will re-load the assembly and re-analyze based upon the assemblies new content.
Properties Pane
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The properties pane for each individual search path node will show you the folder name and the full path to the search path.

References

2.4.1.20 Other Python Projects

2.4.1.21 C++ Projects
2.4.1.22 .NET Assemblies (IronPython)

2.4.2 CWD for Executing Code

When you invoke "Execute File in Python Interactive" (alt-s-F5) on a file in an implicit project, the current working directory (CWD) of the ipy.exe process is the root directory of the project.  The root directory of an implicit project is the one containing the file you opened initially, which created the implicit project.  Since you are likely hitting alt-s-F5 in the file you opened originally, the CWD is likely the directory containing the file that was active when you hit alt-s-F5.
When you invoke "Execute File in Python Interactive" with an explicit project, the current working directory of the ipy.exe process is the root project directory (where the .pyproj file lives).  The project property for the CWD, if it is explicitly set, overrides the project's root directory.  If there is more than one project, the current working directory is the root directory of the active project.

If you just launch the REPL without using "Execute File in Python Interactive" or "Execute Start Item in Python Interactive", and you have a project, then the CWD is the project's root directory.  If there's more than one project, it is the active project's root directory.  If you do not have a project, then the REPL's CWD is the default from the tools options page, see section 3.9.7.  Launching the REPL does not mean just showing the window; it must be the first showing when the executing process gets created, or resetting the execution context (%reset).
Projects have an option you can set to control the current working directory.  You might do this to run the code you're developing from the location you know you'll be launching the application for real when you are done with it.  This option overrides the project's root directory in the description above.
2.4.3 Templates

Python Tools releases with the following templates (all under "Python" as a top-level node in the left navigation pane of the New Project Dialog):

· Windows Command Line -- this is just a collection of .py files from a directory.  There needs to be a start item to invoke "Execute File in Python Interactive" (alt-s-F5) and launch the program.

· Package -- this is a directory template with an __init__.py file

2.4.4 Implicit Project for Opened File

The implicit project assumes all files in the same directory as the file you opened are part of the project for code modeling purposes.  It also includes all files in sub directories which are Python packages (they include an __init__.py file).

While the implicit project is modeled internally there is no user interface for exploring the implicit project.  Solution explorer remains unchanged. 

When you invoke "Execute File in Python Interactive" (alt-s-F5) with an implicit project, Python Tools executes the current editor buffer in the REPL after clearing the execution context of the REPL.

You can select an implicit project item to be the start item, like the explicit project has, and use "Execute Start Item in Python Interactive" (c-a-s-F5).  This command also clears the execution context in the REPL before running the start item of the project.  The difference is that Python Tools does not persist this choice.  

2.5 Interactive Window
There are several ways to execute code in Python Tools:

· invoke "Execute File in Python Interactive" (alt-s-F5) to run the current buffer in an implicit project
· invoke "Execute Start Item in Python Interactive" (alt-s-F5) to run the start item of an explicit project
· invoke "Send to Python Interactive" to evaluate a selected expression from an editor buffer in the REPL
· invoke "Send to Python Module" to evaluate a selected expression from an editor buffer in the REPL after ensuring that the REPL execution context is the same module as represented by the file in the editor buffer

· invoke "Send to Python Defining Context" to evaluate a selected method from an editor buffer in the REPL after ensuring that the REPL execution context is the same module represented by the file in the editor buffer.  This command also patches the containing class to have the new method definition.

· entering and evaluating expressions in the REPL directly

· launching ipy.exe on a file in classic VS debug mode (doesn't run inside REPL)

The REPL is the focus typically for executing code and iteratively developing and exploring code.  Python Tools resets the execution environment on alt-s-F5 commands.  The module name of the REPL after an alt-s-F5 command is "__main__".  You can change the module in which the REPL evaluates input with the %module command.  This allows you to executing code more easily in the context of a file that was imported by the main script.

When you execute a selection from an editor buffer, Python Tools first issues a %module command in the REPL to set the module correctly for the evaluation.  If a file has not executed, but some other files have executed, then attempting to evaluate a selection in that file's buffer results in an error dialog that Python Tools cannot execute the evaluation.  You first need to import or execute the file so that its module exists in this case.  If no files have executed at all, and you evaluate a selection from an editor buffer, the selection evaluates in the default module, __main__.
The REPL options are configurable via the Tools->Options->Python Tools->Interactive Windows pane.  
2.5.1  History, Input Editing, and Interrupting Execution
The primary REPL focus is basic editing, intellisense, and input evaluation.  For interactive development and API exploration the REPL makes it simple and fun to write code (for example, auto-indenting multi-line input).  You can easily access libraries and experiment while developing your application.  After verifying an expression or function you've iteratively developed, Python Tools makes it easy to copy that to an editor buffer for saving in your program, fixing up whitespace and whatnot as needed.
Here are some common commands and bindings used in the REPL:
· Interrupt Execution -- bound to c-break.  Users can bind it to c-c in Tools Options.  On button in tool window toolbar.
· Previous and Next History -- bound to uparrow and downarrow, but the caret must be at the end of the current input or EOB.
· Previous and Next Line -- bound to with uparrow and downarrow everywhere except the end of the current input or EOB.  To edit a multi-line history item or typed input, you first need to use leftarrow or the mouse to navigate away from the end of the input text.  Also, while pending execution of the previous input text, these keys navigate between lines; they do not perform history operations.
· Maybe Execute Input -- bound to enter at the EOB or current input.  Executes the input if it is complete (doesn't end with an operator, in parens, in a construct like 'if' or after 'else:", etc.).
· New Line and Indent -- bound to enter.  See Execute Input for behavior at the end of the current input.
· Execute Input -- bound to c-enter inside the current input.  Executes the current input regardless of caret position or completeness of the expression.
· Force New Line and Indent -- bound to s-enter and always inserts a newline and indents, regardless of where the caret is or whether the previous text in the current input is a complete syntactic form suitable for execution.

· Copy Input for Execution -- bound to c-enter when caret is inside or immediately after a previous input region.  This copies the input to the end of the buffer and leaves the caret at the end of the input.  History is unaffected as if the input were pasted, except the new input does get added as the most recent history item.
· Cancel Input -- bound to escape.  This cuts the current input region, leaving the caret after the prompt.

If you type in read-only region, the REPL scrolls to the current input region and appends the typed input there.
Users can rebind the history commands to something like alt-p and alt-n to rotate the history ring regardless of caret position (perhaps rebinding up/downarrow to normal nav commands).

2.5.2  Tool Window Toolbar

The REPL window has a tool bar with buttons for discovering command and easily accessing them with the mouse:

· help -- show a list of REPL meta commands

· cls -- clears the contents of the REPL editor window without changing execution state or input history

· echo -- suppress or unsuppress output to the buffer

· load -- executes code from a file as if the code were entered as input and support meta commands (% REPL commands)
· reset -- reset to an empty execution engine, keeping buffer contens and input history

· module drop down for changing the module in which code executes

· Interrupt execution button
2.5.2.1 Startup Script
2.5.2.2 Interpreter Options

2.5.2.3 Interactive Mode
2.5.2.4 Arrow Keys use smart history

When smart history is enabled (the default) the up/down arrow keys will navigate history when the caret is at the last character of the buffer.  When this is unchecked the up/down arrow keys will not be bound to history – instead you’ll need to use Alt-Up and Alt-Down to navigate history.
2.5.2.5 Enable attaching to interactive window

2.5.2.6 Use inline prompts

This option is checked by default.  When checked the input prompts will show up mixed in with the output like using the Python at a normal command prompt.  When unchecked a margin will be displayed which includes the prompts.  Changing this at runtime will cause the prompts to be moved to the margin or back inline.
2.5.2.7 Only use live completions

When this option is checked completion information from the analysis engine will not be included in the interactive window.  Instead only live completion information will be used as configured in the Completion Mode section.
2.5.2.8 Use user defined prompts

When this option is checked the user can specify custom prompts.  Otherwise the values are read from sys.ps1 and sys.ps2.  Changing this at runtime will cause all of the prompts in the buffer to be updated.
2.5.2.9 Completion mode

This option controls what expressions will be evaluated when using live completions.  By default expressions which contain method calls are not evaluated but all other expressions are.  You can also choose to never evaluate expressions or to evaluate all expressions.
2.5.3 Command Placements
There is a View -> Other Windows -> Python Interactive command to go to the REPL, creating it if necessary.

There is a Tools -> Python sub menu.  It starts out with "Python Interactive".   If a .py file is open and has focus, it also has "Execute File in Python Interactive".  If there is a selection in the editor, it also has "Send to Python Interactive" and "Send to Python Module".  If there is a project with a start item, then there is an "Execute Start Item in Python Interactive".
There is a Debug -> Execute File in Python Interactive bound to alt-s-F5.  If there is an explicit project active, then there is also an "Execute Start Item in Python Interactive".  If the current file is not a Python file, and there is no active project, the menu item is grey.
There's a tool bar on the REPL tool window with common REPL buttons/commands.

2.5.4 Meta Commands

The following commands can be entered in the REPL to control the REPL itself or for other functionality that is not executing code:

·  $help -- lists $ meta commands.

·  $module [module] -- switches the REPL's execution context to the specified module.  The module must already have been created.  If module is unsupplied, this switches to __main__.

·  $cls -- deletes the REPL buffer's contents and shows a fresh prompt.  This does NOT reset the execution state.

·  $reset -- resets the execution context in the REPL.

2.6 Debugging

Python Tools for Visual Studio supports several different modes of debugging.  The primary mode of debugging is integrated support for debugging Python scripts using Python’s sys.settrace functionality.  PTVS also ships with integrated support for IronPython/.NET debugging and Python cluster debugging.  Both of these debugging modes are available by configuring the debugging options in project properties.
2.6.1 Python Debugging
2.6.1.1 Launching
2.6.1.2 Locals
2.6.1.3 Stack Frames
2.6.1.4 Threads
2.6.1.5 Just My Code
The Visual Studio “Just my Code” feature enables finer grain control of when to break on an exception.  
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Enabling or disabling the “Just my Code” setting in Tools->Options->Debugging will alter how the Exceptions dialog lets the user configure handling of exceptions.  When this option is enabled the user will have the option of specifying the behavior of exceptions when they are thrown and when they’re user-unhandled:
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When the option is disabled the user can only specify whether to break when the exception is thrown:
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Breaking when Thrown

When the user has selected to break when an exception is thrown the debugger will break in whenever that exception is raised.  
Independently of Just my Code users can enable breaking of SystemExit exceptions which have an exit code of 0.  When the user has not enabled this option SystemExit exceptions with a zero exit code will be ignored.
Break when User-unhandled
When the user has selected to break when an exception is user-unhandled the debugger will break only if we cannot find a handler for the exception within the users’ code.  

To determine if the exception is user-unhandled we currently search the current call stack to see if any of the calling frames are surrounded with a try/except statement.  
If a try/except statement is encountered we check and see if it either catches all exceptions or if it is simply catching an exception by name or by a qualified member expression (for example “Exception” or “socket.Error”).  If the expression for determining the type of exception that the except block handles is more complicated it will be ignored to avoid introducing unexpected side effects while debugging.  

If the type of the exception being raised matches the type of exception the except block handles then the exception will not be reported to the user.  
After searching all of the stack frames if a handler has not been found then the debugger will break in and report the unhandled exception to the user.
Exception Dialog
When the exception is reported to the user they are informed whether we are breaking for an unhandled or handled exception.  
An exception which is thrown and handled is reported to the user with a dialog like this:
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An unhandled exception is reported to the user with a dialog like this:
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2.6.1.6 Immediate Window
2.6.1.7 Watch Window
2.6.1.8 Debugging the Standard Library
2.6.2 .NET Debugging
While the typical usage will be executing code in the Python REPL and debugging there, you can launch your code for debugging in a traditional VS style.  You can use the Debug -> Execute Python Start Item command to launch the interpreter as a classic VS debugee process.  In addition to the basic support for stepping, moving the IP, etc., that is available today, Python Tools adds good visualization features for Python objects.  Visualizations include user-defined types, instances of those types, and core data types (Python's dictionaries, lists, and sets).

NOTE: currently the debugging experience is sub optimal by default due to how we generate code and how .NET/VS handle debugging.  You may get errors with the IP in VS at a very high stack frame, and VS will not show all the frames by default.  There is a work around.

Bring up the exceptions dialog (c-d e with C# bindings) and make sure first chance exceptions is unchecked for the .NET framework.  This avoids hitting many exceptions thrown as part of normal Python startup.  Set a breakpoint at a high-level entry point in your code.  When you hit the breakpoint, bring up the exceptions dialog again (c-m-e with C# bindings), and check first chance exceptions for the .NET framework.  Continue execution (F5).  Now you will get the error at the right location of your code.

2.6.3 Cluster Debugging
In addition to normal Python debugging PTVS supports cluster debugging.  This uses the same debug engine which knows and understands Python code but supports deployment of the users program and related VS infrastructure to the cluster and uses the HPC job scheduler to start the users application running on the cluster.  
2.7 Profiling

2.8 Object Browser and Class View

Python Tools for Visual Studio provides type information to the Object Browser and Class View for the domain of its code analysis.  See the Project section for how Python Tools determined what code to analyze.
2.9 Automation

2.10 Tools->Options
2.10.1 Text Editor Tools Options Pages
There's a tools options page under Text Editor called Python.  It has the General and Tabs common options that can be specialized per language.  It also has an Advanced page with the following options:
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2.10.1.1 Completion Results

This group box contains a single option to determine if the intellisense returns the intersection of members of all known types or the union of members of all known types.

2.10.1.2 Selection in Completion List

This group has several different options related to completion behavior.
“Commited by typing the following characters” determines which characters the user may press which will cause intellisense to be committed

“Enter commits current completion determines” if enter will commit the completion or if it will just cause a newline to be inserted into the buffer with the current intellisense session being dismissed.

“Add new line on enter at end of fully typed word” will control whether the enter character (which committed the completion) will also be inserted into the buffer.

2.10.1.3 Miscellaneous Options

“Enter outlining mode when files open” indicates whether or not the file will automatically be outlined with collapsible +/- blocks displayed in the margin.
“Fill paragraph columns” indicates the number of columns which should be used for the Edit->Advanced->Fill Comment Paragraph command.  This is the column number at which text will be wrapped.

“Paste removes REPL prompts” indicates whether or not pasting code which includes REPL prompts (“>>>” and “…”) will have the REPL prompts automatically removed.
· Editor

· Enter outlining mode when files open -- on by default
· Enable auto indent -- on by default

· Interactive Window

· Up/Down arrow keys use smart history -- on by default, means that if you must be at the very end of the input region for up/down arrow to do history, otherwise they navigate in the text.

· Completion Mode -- Never evaluate partial expressions is the default, but you can select to never evaluation partial expressions with calls or to always evaluate partial expressions to get live objects for completion.

There is an Intellisense page with :

· Member completion displays intersection of members -- on by default, turning it off shows union of members when multiple types can flow through a site

· List of characters whose input signals choosing a selected item in the completion list -- '(', ')', ',', ':', '.' are the defaults.
· Enter commits current completion -- off by default

· Add new line to buffer when using enter after fully typing member -- on by default

Some users think the default on showing an intersection vs. a union of members is backwards, waiting for more feedback to change it.
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2.10.2 Python Tools Option Pages

In addition to the editor pages there are a number of features in the Tools->Options->Python Tools page which are not directly related to editing.  These options are grouped into 3 categories: Advanced, Interactive Windows, and Interpreter Options.
2.10.2.1 Advanced Options
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Prompt Before running when errors are present
When this option is checked when running a file or project via Debug->Execute you will first get prompted if you want to run if there are any syntax errors in any of the open projects.  If this option is unchecked then there will be no prompt and the files will be attempted to be run.

By default this option is checked.
Wait for input when process exits abnormally

When this option is checked if the process exits abnormally (with a non-zero exit code) then there will be a “Press any key to continue…” prompt.  

This option will not apply in circumstances where it does not make sense.  This includes when the application is a Windows application which does not have a console to read input from.  It also applies to MPI cluster debugging where again there is no console to prompt.  It also does not apply when using .NET debugging as it is impossible to add the additional pause in that case.

By default this option is checked.
Wait for input when process exits normally

When this option is checked if the process exits normally (with a zero exit code) then there will be a “Press any key to continue…” prompt.

This option will not apply in circumstances where it does not make sense.  This includes when the application is a Windows application which does not have a console to read input from.  It also applies to MPI cluster debugging where again there is no console to prompt.  It also does not apply when using .NET debugging as it is impossible to add the additional pause in that case.

By default this option is unchecked.
Tee program output to Debug Output window

When this option is checked output to standard output will also show up in the Visual Studio Debug->Windows->Output window.

By default this option is checked.

Break on SystemExit exception with exit code of zero

When this option is enabled the debugger will break on a SystemExit exception with  an exit code by zero if configured to break on SystemExit exceptions in the Debug->Exceptions dialog.  When this is unchecked the debugger will never break on a SystemExit exception with an exit code of zero.
By default this option is unchecked.
Automatically analyze standard library in background

When this option is enabled the first time you open a project or file that targets a specific interpreter the standard library will be automatically analyzed in the background.  When this option is unchecked you’ll need to manually generate a completion database in Tools->Options->Python Tools->Interpreter Options.
By default this option is checked.

Update search paths when adding linked files

When this option is enabled search paths will be automatically updated when adding linked files.  The update will cause the directory containing the newly added files to be appended to the search path.  If the files exist within a package then the package directory will be added to the search paths so that the package can successfully be imported.
Report inconsistent indentation as

This option controls how inconsistent indentation (mixed tabs and spaces, as reported by the Python interpreter when using the –t and –tt options on 2.x) is reported.  Available options are to ignore it entirely, report it as a warning, or report it as an error.  
By default this option is set to report inconsistent indentation as a warning.
2.10.2.2 Interactive Windows
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This pane displays options for the interactive windows.  There’s a drop down at the top which allows the user to select which interpreter to configure (the list of interpreters is on the Interpreter Options pane).  The options below apply to the interpreter which is selected.

Startup Script
This specifies a script which is run on the startup of the interactive window.  This script can be used to setup a custom environment such as importing modules.  This runs after site.py. 
By default no startup script is configured.
Interpreter Options

This specifies command line options which are passed to the interpreter.  Users can specify options such as –O or –OO or other options the interpreter will accept.  
By default no options are specified.
Interactive Mode

This specifies the backend which is used for the interpreter.  By default PTVS ships with two modes: Standard and IPython.  

Standard mode is designed to work with any Python interpreter and works like the normal REPL experience most users are accustomed to.
IPython mode uses ZMQ to talk to a IPython engine and allows IPython to handle all of the processing of inputs, provide completions, etc..   

Additional execution modes can be registered in HKLM\Software\VisualStudio\Hive\PythonTools\ReplExecutionModes.  A key should exist here where the name is the mode ID (this is not displayed to the user and is typically a GUID).

This registration should have the following values:

	Value Name
	Value Type
	Descrpition

	SupportsMultipleScopes
	string
	True if the multiple scope drop down should be enabled



	Type
	string
	The fully qualified type name (e.g. modulename.typename) which implements the REPL backend.  The REPL will attempt to import this module and load the type from it.



	FriendlyName
	string
	The name which should be displayed to the user.


In addition to the list of registered values the user can insert a fully qualified type name (module name.type name) into the combo box to manually specify a type name.  This is the same as having a value registered with the “Type” that they typed.
Arrow Keys use smart history

When this option is enabled pressing up or down will cycle through history of the cursor is at the end of the current REPL buffer.  When this option is disabled, or the cursor is not at the end of the current input, then the up/down arrow keys will navigate the interactive window buffer.

Users can also navigate history using the HistoryNext / HistoryPrevious commands.  By default these are bound to Alt-Down and Alt-Up.

By default this option is enabled.
Enable attaching to the interactive window

When this option is enabled a $attach command is supported which allows attaching the Visual Studio debugger to the interactive window.  Breakpoints can then be set which allows debugging the REPL process.
By default this option is disabled.
Use inline prompts

When this option is enabled prompts are displayed inline in the text buffer.  When this option is disabled prompts are displayed in the margin keeping them separate from the code the user is entering and editing.

By default this option is disabled.
Only use live completions

When this option is enabled completions will be returned only from inspecting the live objects – the interactive window will not attempt to analyze the inputs statically to give completions.

By default this option is disabled.
Use user defined prompts

When this option is enabled sys.ps1 and sys.ps2 will not be read for the prompts and instead the settings the user specifies will be used.

Prompts support having \[char] escape sequences which include extra information.  Supported escape codes are:
	Escape Character
	Description

	\
	Inserts a backslash into the prompt

	#
	Inserts the prompt ID into the prompt

	D
	Inserts the date into the prompt

	T
	Inserts the time into the prompt


Unrecognized escape characters will be appended literally including the backslash.

By default this option is disabled.
Primary Prompt

Specifies the prompt used for the first line of input for each multi-line input.

This option is only enabled if Use user defined prompts is checked.
Secondary Prompt

Specifies the prompt used for the second and additional lines of inputs for each multi-line input.

This option is only enabled if Use user defined prompts is checked.
Completion Mode

This option specifies what code the interactive window may execute to present completions.  
	Option
	Description

	Never evaluate expressions
	Expressions will never be evaluated for live completions

	Never evaluate calls
	Expressions containing calls (“foo().”) will not be evaluated, all other expressions will be evaluated for completions.

	Always evaluate
	All expressions will be evaluated for completions.


Options include to never evaluate expressions, to never evaluate calls, and to always evaluate expressions.
By default this option is set to not evaluate calls.
2.10.2.3 Interpreter Options
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This options page specifies the configured interpreters including those which were automatically detected by PTVS and those which have been manually configured by the user.  The user can also select the default interpreter, add new interpreters, remove manually configured interpreters, and generate the completion database for an interpreter.

Default Interpreter
This configures the default interpreter that is used for projects which do not have an interpreter specified or loose files which do not live within a project.  
Show Settings For

This specifies which interpreter is currently being viewed/edited in the Interpreter Settings area.
Add Interpreter

This creates a new user-configured interpreter.  The user is prompted for a new name for the interpreter and then can configure the settings in the Interpreter Settings area of this page.
Interpreter Settings

This displays the interpreter settings for the currently selected interpreter in “Show settings for” and allows the user to edit interpreter options for manually configured interpreters.  If an interpreter was automatically discovered by PTVS the options will be grayed out.
Path
This specifies the path to the interpreter executable such as python.exe, ipy.exe, or pypy.exe.
Windows Path

This specifies the path to the interpreter executable for launching consoleless Windows applications such as pythonw.exe or ipyw.exe
Architecture

This specifies the processor architecture of the interpreter – x86 or x64.
Language Version

This specifies the version of the Python language which this interpreter supports.   Versions 2.5 through 3.2 are currently supported and this determines how the source files are parsed by PTVS.
Path Environment Variable

This specifies the environment variable that is used for setting sys.path.  For CPython and PyPy this is PYTHONPATH, for IronPython this is IRONPYTHONPATH, and for Jython this is JYTHONPATH.
3 Extensibility
3.1 Publishing
Custom publishers can be implemented which support deploying the project to a remote location.  This allows a seamless experience for the user when doing web development, cluster, device or other remote development and debugging scenarios.
3.1.1 IProjectPublisher

The IProjectPublisher interface Implements a publisher which handles publishing the list of files to a destination.  The interface also provides properties for giving the user information about the publisher.  This interface is exported via MEF:

[Export(typeof(IProjectPublisher))]

3.1.1.1 PublishFiles

void PublishFiles(IPublishProject project, Uri destination);

Publishes the files listed in the given project to the provided URI.

This function should return when publishing is complete or throw an exception if publishing fails.
project: The project to be published

destination: The destination URI for the project.
3.1.1.2 DestinationDescription

Gets a localized description of the destination type (web site, file share, etc...)

3.1.1.3 Schema

Gets the schema supported by this publisher - used to select which publisher will

be used based upon the schema of the Uri provided by the user.

3.1.2 IPublishProject

3.1.2.1 Files Property

Gets the list of files which need to be published.
3.1.2.2 ProjectDir Property

Gets the root directory of the project.
3.1.2.3 Progress Property

Gets or sets the progress of the publishing.

3.2 Launching / Debugging
3.2.1 IPythonLauncherProvider
This interface is implemented by extenders who wish to provide alternate mechanisms for launching Python applications.  The provider provides the information to allow the user to select and configure the launcher as well as a way to create the IProjectLauncher which will be used for actually launching the project.
3.2.1.1 GetLauncherOptions

Gets the options for the provided launcher.

3.2.1.2 Name

Gets the name of the launcher.

3.2.1.3 Description

Gets a longer description of the launcher.

3.2.1.4 CreateLauncher

Creates an IProjectLauncher for the provided IPythonProject project.
3.2.2 IProjectLauncher
Defines an interface for launching a project or a file with or without debugging.

3.2.2.1 LaunchProject
int LaunchProject(bool debug);

Starts a project with or without debugging.

Returns an HRESULT indicating success or failure.
debug: true if a debug launch is requested.
3.2.2.2 LaunchFile
int LaunchFile(string file, bool debug);

Starts a file in a project with or without debugging.

Returns an HRESULT indicating success or failure.

file: the filename to de launched

debug: true if a debug launch is requested.
3.2.3 IPythonProject
Provides access to the Python project including getting and setting options, getting the Python interpreter  that’s been configured, and publishing the project.
3.2.3.1 GetProperty
string GetProperty(string name);

Gets a property for the project.  Users can get/set their own properties, also these properties are available:

    CommandLineArguments -> arguments to be passed to the debugged program.

    InterpreterPath  -> gets a configured directory where the interpreter should be launched from.

    IsWindowsApplication -> determines whether or not the application is a windows application (for which no console window should be created)

3.2.3.2 SetProperty

void SetProperty(string name, string value);

Sets a property for the project.  See GetProperty for more information on common properties.

3.2.3.3 GetWorkingDirectory
string GetWorkingDirectory();

Gets the working directory that the program should be launched in.  This is either a directory configured by the user or the project directory.
3.2.3.4 GetStartupFile

string GetStartupFile();

Gets the .py file which should be the initial entry point of the Python project.

3.2.3.5 ProjectDirectory

string ProjectDirectory {

    get;

}

Gets the directory which the project lives in.

3.2.3.6 ProjectName

string ProjectName {

    get;

}

Gets the name of the project.

3.2.3.7 GetInterpreterFactory

IPythonInterpreterFactory GetInterpreterFactory();

Gets the interpreter factory that this project has been configured to use.

3.2.3.8 Publish
bool Publish(PublishProjectOptions options);

Publishes the project as configured in the Publish dialog of project properties.

If publishing is not configured this function returns false. If publishing succeeds this function returns true.

If publishing fails this function raises a PublishFailedException with an inner exception indicating the 

precise reason for failure.

4 Scenarios or Storyboards

4.1 Writing a Script

Jane wants to write a script (single file of code) to execute for a specific task.  She is going to copy some code that does a similar task that John wrote for his desktop management scripts.  Jane's going to modify the script to suit her purposes.  She launches VS and then opens the file of code from John.  She sees the code is colorized.

Jane starts editing the file.  She enters import statements and gets completion lists of available CPython and Python libraries on her path.  These completions are based on information from the Python engine and Python semantics of search paths.  Jane could also set options for the current working directory in which to launch her scripts, and the Python features would provide library completions appropriate to that directory.  Jane also gets completion while importing .NET assembly namespaces from referenced DLLs.  Python Tools has default references for projects, and if she adds references to other DLLs, then she gets completion on their namespaces too.

As Jane enters her code, it colorizes as Python code.  She enjoys auto-indenting as she hits enter and types code.  If the next line's indentation was incorrect (ending a control construct, adding an 'else' instead of another consequent statement, etc), she hits backspace once to go back one indentation level.  She gets completion on any identifiers that occur in the buffer by pressing a key that requests completion, and she can select from possible completions if the partial identifier is not a unique initial substring.  Also, if she sufficiently qualifies an identifier relative to her imported libraries and .NET namespaces, she gets completion on those identifiers without any popping UI.  For example, if Jane imported System, she could type "Sys" and complete "System".  She could then type a dot followed by "Env" and complete "Envionment".

If Jane tries to complete a name based on a member access relative to a variable, she gets very good assistance due to our code analysis.  The variable's type might be known because it is in a scope (and within a lifetime) where the variable has been set to the result of constructing a type or calling a .NET static method that returns a known static type.  Similarly, ignoring that dynamic run time changes to types may invalidate completion information, if a variable were set to the result of constructing a Python type, there might be analysis information for completing the members of that type.  For example, the language engine may analyze slot declarations or initialization/constructor functions to determine possible members. 

Jane realizes there's part of John's code that does exactly what she wants, and she likes how he's solved the logic and corner cases.  She decides to keep those functions just as they are in another library that she'll use from her Python script.  She cuts all the code she doesn't need from her file and saves it to a directory on her Python path or to the working directory where she'll be running her new script.  She adds a new import statement to the top of her Python file.  As she goes on to write her code she can complete the names from the new library of the functions after adding the import statement.

Of course, while Jane is editing, she has all the basic text permuting, navigation, and searching operations.  She can move around in units of lines, characters, and words (constituent characters determined by settings or language engine query).  She can delete and select in these textual units as well.  She can scroll the script pane up and down over the buffer of text, and she can also scroll from the keyboard so that the caret does not change its location.  She uses the latter functionality to bump the pane a line (or several lines) at a time to move the area where she's working to the middle of the pane to see more surrounding context.  Because she's used to seeing code in the middle of her pane, she might scroll the pane so that there's several lines of whitespace at the bottom of the pane, even though the end of the buffer is in the middle of the pane where she's typing.  Jane can also search through the buffer from the caret's location to the bottom of the buffer (or backwards the beginning), and she can do so optionally replacing find hits with a replacement string.

While writing her code, Jane is mixing totally new code and code fragments lifted from John.  She is also commenting her code so that others can readily understand what it does.  She pastes in some code from John, and she morphs it easily into what she needs.  Jane selects the modified code and uses rigid indenting commands to move the code left or right to fit into her code while keeping the same relative indentation of each line.  Jane is happy that John commented his code; however, as Jane moved the code left and right and slightly tweaked the code, she needed to update the comments to be correct and to fit the width to which she formats code.  She uses the fill paragraph command (which shortens some lines and lengthens others by inserting and removing newline sequences) so that all lines in comments are as long as they can be without going past the column to which she formats code.  Jane uses this command frequently when she updates code or refactors code so that her comments are up to date and formatted to her liking.

Jane is ready to try out some of the code she's written.  She knows it is not complete, and she needs to investigate some fragments of code and some objects to see how best to use them.  She hits F5 to load her code into a script engine.  Jane sees the interaction pane below the script pane echo'ing the reset for her module, as well as any output side-effects of loading her script.  The execution engine associated with Jane's program is totally distinct from the one that executes Python code against the VS Automation Model.  Jane can reset the program's engine state or suffer code crashes, without any effect on VS.

See the next section for an interaction pane scenario or storyboard.

4.2 Dynamically Developing Code in an Interaction Pane

Jane wants to explore some code fragments and objects to finish writing a script she was working on, as well as test some parts of the script.  Jane has just loaded her code, and the interaction pane shows a prompt following the load.  To load her code Jane could have launched VS, used the command to launch an interaction window, and imported her code at the command line.  Alternatively, Jane could have launched VS, opened a file of code, and hit F5.

The only difference in these two approaches is the module context (or scope for name binding) in which the interaction window evaluates.  Viewing the REPL window with no file context yields an empty, default global module.  Importing Jane's file of code then just creates a global name bound to the module.  Hitting F5 in a Python buffer causes the execution engine's to load all the top-level names into the default module.  In one case Jane has to qualify global functions in the default module with her module's name (for example, MyScript.Myfunc).  In the F5 case, all of Jane's module's global definitions are available without having to qualify them.

Jane wrote a top-level function that is the entry point to her script, and it has the logic to conduct the overall mission of her script.  However, she knows she left some of the functions unwritten, and she knows she has some broken code fragments in some of the functions.  Jane picks one of the functions to fix, which involves figuring out how to work with a .NET object she's unfamiliar with.  Jane needs a result from using this .NET type, which she then passes to a lower level function she already wrote.

Before learning about that .NET type, Jane decides to quickly confirm that her lower-level function works.  She types into the interaction window a series of inputs to construct a few objects and link them together (perhaps using a list or using pointers between the objects).  When Jane hits enter after a well formed input, the interaction window sends that input to the execution engine for evaluation.  Jane invokes the lower-level function, and it works.  She changes the objects a few times to make sure the function handles corner cases.  Jane both makes calls on the objects to change them and re-evaluates past input that she modifies before hitting enter.  Jane can evaluate previous inputs by using the interaction window's history commands, which rotate through previous complete inputs (not a line at a time).  She can also move up in the editor buffer in the interaction window and hit c-enter after a line of input.  Python Tools copies the line or complete input fragment ending on that line to the end of the interaction window so that the copied text is appended to any other input waiting to be confirmed in the interaction window.  Jane realizes her helper function is solid.  Now Jane is ready to figure out how to get the objects she needs from the .NET object she is unfamiliar with.

Jane navigates (using a key binding) to the Python buffer with her code.  She selects part of the code that creates the .NET object.  She uses commands to evaluate the selection as though it were input to the interaction window.  She doesn't have to evaluate any imports or references to .NET DLLs since she's already loaded her file of code.  Jane flips between the script and interaction windows to evaluate code, depending on what she's doing, and the interaction window correctly interleaves input and output so that there is a correct record of the flow of interactions.  Each printed result follows the input that produced it.  Even if Jane were to paste several complete expressions or statements (with newline sequences after each) into the interaction window, the results for each individual input would immediately follow that input.  This is important for Jane to be able to look back at her interactions and make sense of them.  It also aids her grabbing several correct lines of input to paste them back into her script code to build a function or to write a unit test.

Let's get back to Jane's playing with the .NET object she just created.  First she fetches a list of members on the object (using 'dir' in Python).  After skimming the names, she gets help on the type by just entering the type's name (which evaluates to the type) and passing it to a documentation function.  The 'help' function provides her with a summary of the type so that she sees short descriptions for the members.  Jane uses the help function on specific members to get summary, remarks, example text, etc., that's available in the doc comments or built-in help for the members that may come from Python.  Jane tries a few members out, just calling them based on the signatures and help.  She gets errors, tries again, and iterates until she thinks she knows how to use the object and get the results she needs.  Of course, she's also consulted examples in MSDN or the net in general as needed.

While typing code in the interaction window and viewing printed results, member lists, and help, Jane has all the functionality of the editor behind her in terms of coloring, searching, etc.  Past input sections of the buffer might be read-only so that Jane doesn't inadvertently change the input and forget what produced the associated output.  She can always edit previous input by copying it to a new editor buffer, the buffer containing her script, or to the end of the interaction buffer.

As a side note, completion works in the interaction window.  In the REPL window completion is a combination of code analysis and live object inspection.  In the future, Python Tools may support live object inspection in editor buffers, especially when the engine is stopped at a break point with appropriate stack frame and local bindings info.

As Jane figures out code fragments she needs and how to fix up all her code, she pastes code into the Python buffer from the interaction window, re-indents the code, adds comments, reformats the comment paragraphs, etc.  She selects whole functions she's fixed up and evaluates those back into the script engine behind the interaction window.  She sees all that input with associated output properly ordered in the interaction window.  She's also been writing little helper functions in the interaction window or in her script's file, as well as creating and re-creating various data structure fragments or objects to help her play with and test her code.  Some of this she saves for unit testing or future development helpers.

After fixing up the lower-level functions, Jane is ready to try her code from the top down.  She could just call her top-level entry point function, but she thinks her current environment is pretty cluttered and patched together at this point.  She decides to get a fresh result and hits F5 in the Python buffer.  This resets the module in the execution engine completely, losing global variable bindings, ephemeral definitions of helper functions defined in the interaction window, etc.  The interaction buffer still contains all her work for the VS session, or from the last %cls command.

Before hitting F5, Jane also added some code at the end of her script to call the top-level entry point when her script is loaded, as opposed to just defining the function but never calling it in the script.  For example, in Python, Jane would add something like the following:

If __name__ == "__main__":

    DoMyMainThang(argv)

Jane's script has a bug in it, and the interaction window (after some text about resetting the module) displays the prompt for the command line debugger.  See the next section for scenario/storyboard information on debugging.

5 Future Ideas

This section represents ideas which are not yet implemented or fully defined.
5.1 Customizing Visual Studio with Python Code

Still need to think about what we want to do for Python Tools.  The strike through text is from a long ago prototype.
5.1.1 MEF helpers

5.1.2 Macros/Funs -> cmd/key binding
Jane wants to customize Nessie, and she sees from the documentation that she can create an init file for herself that overrides defaults.  She uses a command that opens init files, and it can create init files too.  This command is different than the normal Open File command because it creates a Python buffer that modifies the script environment that's running Nessie's commands code.  Jane can either create the init file in the settings and documents app data directory for Nessie, or she can set the environment variable NESSIE_INIT so that Nessie finds the file wherever she puts it.  She copies some settings from the default init file (or an example of a default init file) and changes settings she copied.  For now, Jane just changes the default indentation level from four spaces to two spaces, and sets the paragraph fill column to 78 characters.

After using Nessie a while longer, Jane really misses having delete-horizontal-whitespace and open-line commands.  She goes back to the init file and sets the path variable for where Nessie looks for command files.  She appends to the path a directory where she keeps tool customizations.  Jane then uses a new file command that opens a new Nessie script file for JSX.  She also use the Nessie script open command to open one of the files of commands that came with Nessie.  These new and open commands open files so that evaluations use an interaction window that affects the Nessie commands script environment.  Jane pokes around in the file of commands that came with Nessie to find examples that inform what she's trying to do.  She writes the two top-level functions in her new file and saves it.

Jane doesn't want to restart Nessie to fixup its path, so she uses the Nessie customization interaction window.  She evaluates the line that sets the commands search path.  Jane does not have to do anything else to pick up the new commands for two reasons.  First, setting the path causes Nessie to look for new directories and files since it read commands files last.  Second, Nessie notices changed directories and files and asks to reload them, which Jane could turn off if she were making several modifications to an existing file and didn't want Nessie trying to reload the file on every save.

Jane tries out the commands, and she didn't get them quite right.  She goes to her new commands file and uses a command that sets the Nessie customization interaction window's context to her file's language and module.  Then she switches to the interaction window and plays with code fragments on the command line as well as evaluating selections in her commands file.  She figures out how a couple editor primitives work and how to call them to make her new commands work correctly.  She saves the file, which causes Nessie to incorporate the new definitions now that the file's directory is on the commands path.  Jane does not have to re-evaluate them in the interaction window as she would when writing a normal program.

Lastly, for today, Jane decides to add key bindings for her commands, so she decides to do that in her init file rather than the commands file.  This way if someone else wants to take her commands file, they can decide on their own key bindings.  When Jane saves the init file, Nessie does not reload it because often changes in init files are not functionally independent and can have cumulative effects (for example, appending the same path over and over to the commands path).  Jane copies the two lines of code that bind her new commands to keys into the interaction window, and she evaluates them to get key bindings.
5.2 P2: Scripting Visual Studio with Python

Python Tools also supports using Python as a scripting and extension language for VS.  There is a distinct REPL that is specific to the VS process instead of to the application you are building with Python.  The VS process REPL starts up with an implicit import of DTE, the root of the VS object model.  You can write functions and then add them as commands or bind them to keys.  This REPL has distinct markings or coloring as well as a different tool window name to distinguish it from the REPL used to develop your Python program.

Through the DTE object, you can enumerate projects and files in solutions, access items for reading or modifying, get to the editor's object model, tool windows, etc.  We will provide some small convenience functions making it easy to accomplish certain scenarios.  For example, DTE.GetObject("PythonDteHelpers").BindCommand might take a string representation of a key sequence and an Python function, setting up the function as the command handler for the key binding.

What other support is there such as a way to write a MEF extension that we're the dispatcher for in terms of loading Python files when the extension is loaded?

5.3 P2: Column Guide

Since PEP 8 and general python conventions are to break code at column 80, we should offer a column guide.  VS used to have this, but in dev10 it is in the power pack found in the Extension Manager.  Notepad2 has this feature as well as other editors.  IPyTools should offer this feature rather than require downloading and installing all of the power pack; also, we want an option for the column and do not want context menu commands for setting it up.

There is an option for the column to use.  When this is turned on, the user sees a light grey line down editor buffer panes at that column.
5.4 P2: Identifier Completion Works in Comments and Strings

This is not implemented yet.

5.5 P2: Filter Completion Lists from Type In

Filter the completion list based on what the user has typed.  There are several options here, but basically we could mimic C# (initial substring, contains string, pascal casing abbreviations, etc.).

5.6 P2: NavigateTo Command Support

NavigateTo is a feature that finds identifiers and files based on substring matching and matching just the camel-cased characters in the name.  It is a handy, quick navigation feature introduced in VS 10, but it requires special support rather than just using the APIs supplied for completion, object browser, or class view.

5.7 Building Projects

The typical experience for developing apps is to just edit code and execute the current buffer, selected expressions from editor buffers, entered expression in the REPL, or the start item for an explicit project.  However Python Tools supports compiling projects into EXEs.  This support uses the existing Python compilation support via pyc/clr.CompileModules.  It does not support be any form of “static” compilation such as producing .NET DLLs that C# and VB can link and build against.

P3: We could consider a command for compiling to a stand-alone EXE.  We could compile Python.dll/Python.Modules/etc… into .NET modules instead of compiling them as normal DLLs.  Then the user code could also be compiled to a module.  These could all be link.exe'ed into one .EXE, giving the user a single EXE to deploy.

5.8 Miscellaneous Files and Multiple Domains of Code Analysis

Regardless of whether you have an explicit project or an implicit one, there are situations when you open .py files that are not in the current project.  Code modeling for that file should pick up a distinct set of files for smart editor features.

If you open a file that is not considered to be in the implicit or explicit project, Python Tools do model the code in these file.  However, currently there is a single domain of code modeling.  It is as if these miscellaneous files are part of the project once they are opened.

The miscellaneous files may be listed in the misc files project or in their own distinct Python Tools project.  This is TBD depending on VS.

5.9 Saving Code from the REPL to an Editor Buffer

After exploring code and getting a function or expression to work in the REPL, you want to save that in an editor buffer or project item where you are building you program.  Code formats appropriately where you drop it, trims any funky prompting artifacts, etc.

5.10 Debugging In-situ, Recursively in the REPL

These behaviors may be on a tools options.  We won't have this support for quite a while, but we should work with pdb.py soon.
Exact debug command names are not spec, just examples.

Jane has loaded a file of Python code into the interactive window by hitting F5 in a Python buffer associated with the file.  While running the code, she hit a bug.  The interactive window displays the debugger's prompt.  Jane enters "bt" to get a backtrace printed.  She sees a terse printing of each stack frame relating to script code or .NET calls script code made.  The frame print representation is essentially the function's name and the arguments passed to it.

Jane moves up the stack a few frames and types "l" to see locals for that frame.  This is enough for her to see the problem.  She enters a line of code to get a few values out of objects that a couple of locals are bound to, and her hypothesis is correct about what's wrong.  Code she enters at a debugger prompt binds variables in her expressions to locals in that stack frame first, then to globals, etc.  She enters "q" to quit the debugger and return to the interaction window's top level prompt, cleaning up the call stack on the way.

Jane navigates (using a key binding) to the Python buffer for her code and fixes the bug.  She selects the function and uses the Python buffer's command to evaluate the selection, which redefines the function in its module.  She often works with the code side by side with the interaction window, so she sees the selected text pop into the interaction window as input to get evaluated.

Jane navigates (using a key binding) back to the interaction window.  She calls the initialization function for a global variable and sets the global to the result so that the code will run fine.  She then calls her top-level entry point again.  This time the code runs farther, but she hits another error.  That's fine, she knew she was going to have to shake down the code.  This time she realizes a couple of frames up that there was a function called with two arguments passed in the wrong order.  She goes to that frame and enters "dbg_return(<expr>)", where <expr> is a call to the function.  Jane uses the locals to get the values but places the arguments to the function in the right order.

The execution engine evaluates the argument to dbg_return to get one or more return values.  Dbg_return unwinds the stack and causes the return value(s) to be returned from the stack frame where Jane called dbg_return.  This let's her keep running her code without having to re-run it from scratch and re-establish global state again.  That's a big time savings since there could have been several prompts or steps for her to get to this failure point again.  Jane navigates back to the Python buffer to fix the code she worked around in the debugger.  She saves the file, but she doesn't bother re-evaluating this function now since it doesn't get called again.

As an aside, if Jane evaluates code from the Python buffer while the execution engine is running some input, Python Tools queues the input.  We could just report that the interaction window is busy.  If there is an evaluation in the queue, and the interaction window's current execution hits an exception, Python Tools dumps the queue of input to make sure it doesn't affect the debugging state before Jane can look at it.

After some edit/test cycles, the code works on simple data.  Jane decides to go all out and calls her entry point function again on complex data.  This time nothing appears to happen.  Jane types ^c to interrupt the program, and she lands in the debugger.  She enters "bt" to see the stack backtrace, and she looks at the line number for where the stack frame is executing.  She goes to her code to look there, and she's in the middle of a pretty simple loop.  Jane goes back to the interaction window and pokes around at some locals, drilling into a couple of the objects a few levels.  She decides to step through some code from where she stopped.  As she suspected, she's infinitely looping, and she's confirmed why.

Jane fixes that problem.  She goes on to try various tests and make sure her code is running well.  She saves some of the interactions to fold into a few test cases for regression testing her code in the future.

5.11 P2: In-situ, Recursive Style Debugging

Python Tools supports in-situ, recursive style debugging in the REPL (such as with sys.settrace).  This is Lisp-style or Smalltalk-style debugging where you drop into the debugger right in the REPL.  You can move up and down the stack, see and change locals, eval expressions in the context of stack frames, and continue running.

In-situ recursive debugging requires significant support while the normal Visual Studio debugging experience is low hanging fruit given what Python already has always had this.  The in-situ, recursive style debugging in the REPL needs custom debugging support.

5.12 P2: TDD support for VS Features

This is a place holder section to remember to spec something here.

5.13 Stack Rank of P2 Features

Some may get cherry picked for v1, but these are planned for v2:

· navigate-to

· debugging (higher cost, may not get done second)

· templates for C#/VB .NET apps hosting via DLR Scripting Hosting APIs

· filter completion list like C#

· column guide (have code, just need to integrate and add option)

· VS Scripting REPL and helper object for pushing cmds, etc. (i.e., macro writing)

· show implicit project for add/remove files in sln expl

· build project to .exe

· id completion like IDLE has

· TDD development support
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